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(1) Automeshing

(2) Definition of Domain/Sub-domain for slab and wall 
design

(3) Addition of Create Converted Line Elements function

ŀƴŘ  ƳǳŎƘ ƳƻǊŜΧ

(1) Applying Plate and Solid Elements to Structural Masonry 
Material 

(2) Addition of Time Dependent Material as per 
Eurocode2:04

(3) Addition of Time Dependent Material as per IRC:18-2000

ŀƴŘ  ƳǳŎƘ ƳƻǊŜΧ

(1) Addition of Capacity Design as per NTC2008 and 
Eurocode8-1:2004

(2) Addition of Slab/Wall Design as per Eurocode2-1-1:2004

(3) Improvements in Rebar Input Dialog box

ŀƴŘ  ƳǳŎƘ ƳƻǊŜΧ
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(1) Automeshing

(2) Definition of Domain/Sub-domain for slab and wall design

(3) Addition of Create Converted Line Elements function

(4) Assigning wind and seismic loads  on a structure with meshed slabs

(5) Enhanced Beam Wizard

(6) Addition of composite sections

(7) Addition of the inverted T-shape beam

(8) Improvements in IS808 section DB

(9) Addition of Chinese section DB (GB-YB05)

(10) Converting Inertial Forces from RS analysis to Nodal  Loads

(11) Addition of Cutting Diagram Display for Plane Strain elements 

(12) Display Stiffness of Rigid Type Elastic Link in the Analysis Output File 

(13) Shading for Solid and Planar Elements in Wireframe View

(14) Display element color by element type, material type, or section type 

(15) Enhanced Display of Supports  and Point Spring Supports

(16) Addition of an export to Excel option in result tables

(17) Save an image in jpg format 

(18) Export frame model to solid/plate model 

(19) Addition of Sort Groups by Name feature 

(20) Renumbering the existing element numbers in reverse order

(21) Addition of the Preference for online help

(22) Addition of auto-generation of wind loads 

according to the latest Korean Building Code (KBC2008)

(23) Addition of static and dynamic seismic loads 

according to the latest Korean Building Code (KBC2008)

ÇList of Detailed Enhancements in Pre & Post Processing
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Meshgenerationfeaturehasbeennewly implementedfor slabandwall members. Generated

meshelementsare fully compatiblewith analysisand designfeatures. Automeshconsidering

interior nodes,elements,andopeningsisavailable.

Automesh Map-meshof 4-Node

Usingthe Auto-meshPlanarArea

function, we can generate

meshes on areas of various

shapes. In order to specify the

area, select the corresponding

Nodes,Line elements,or Planar

elements.

Using the Map-mesh 4-Node

Area function, we can generate

regularmeshshapesfor anyarea

of 4-nodes. We can specify the

numberof divisionsfor the Xand

Y-axisseparately.

Automesh and Map-mesh

1. Automeshing

Model > Mesh > Auto-mesh Planar Area

Model > Mesh > Map-mesh 4-Node Area
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Checkon the MeshInner Domainoption

to generate meshes in the interior

openings. Whenthis option ischeckedoff,

the programautomaticallyrecognizesthe

enclosedareas,and mesh elements are

not generatedin the correspondingareas.

Mesh Inner Domain is checked off as

default.

Mesh Inner Domain option

Include Interior Nodes/Lines option

Check on Include Interior Nodes/Lines

option to considernodes or lines when

generating meshes. In order to specify

nodes and lines, auto and user defined

methodsareavailable.

Include Interior Nodes/Linesoption can

consider beam, planer, and solid

elements.

Boundary Connectivity

Boundaryconnectivityfor adjacentareas

is automatically considered. If the user

doesnot want to considerthe boundary

connectivity, the user can checkoff the

Include Boundary Connectivity option.

Thisoption ischeckedon asdefault. Meshing

Meshing

Meshing

Meshing
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Check on the Delete Boundary Line

Element option to delete line elements

when generating meshes. When this

option is checkedoff and the Subdivide

SourceLineElementoption is checkedon,

line elementswill be divided relevant to

the meshsize.

Delete Boundary Line Element

When mesh elements are generated,

boundary line elements are divided

relevant to the mesh size. Divided line

elementsare assignedasone memberfor

design.

This option is activated when Delete

SourceLineElementoption ischeckedoff.

Subdivide Boundary Line Element

Meshing

Meshing

When mesh elements are generated,

predefined loads are automatically

redistributedalongthe meshelements.

Redistribute pressure loads

Meshing
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Automesh and design procedure

Parapet Automesh (Extrude : Line -> Planar)

Analysis & Design

Copy

Slab Automesh

Make a polygon for meshing
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2. Definition of Domain/Sub-domain for slab and wall design 

Model > Mesh > Auto-mesh Planar Area

Model > Mesh > Map-mesh 4-Node Area

Domain

[1]

[2]

[3]

[4]

Sub-Domain

Meshing

Thedomainis automaticallydefinedwhen generatingmeshes. Elementswhichare definedas

onedomaincanhavethe identicalelementtype,materialproperty,andthickness.

One domain consistsof several sub-domains representingeach slab span. For each sub-

domain,we canspecifythe rebardirectionfor slabdesign.

X

Y

1

Dir. 1

Dir. 2

GCS

Rebar direction
Dir.1: Angle of rebar from Global X-axis
Dir.2: Angle of rebar from Dir.1 Display sub-domain angle
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Generate line beam elements on the outline of the planar elements. When Create only on 

Periphery Regionoption is checked on, beam elements are generated on the outermost lines 

only. This function is useful in creating line elements after meshing plate elements. 

Simultaneous conversion 
by multiple selection

WhenCreate Only on Periphery Region option 
is checked on

When Create Only on Periphery Regionoption 
is checked off

Model > Element > Create Converted Line Elements

3. Addition of Create Converted Line Elements function
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Model > Building > Control Data

Wind Load

Seismic Load

Concentrated Load Torsion

Concentrated Load Torsion

4. Assigning wind and seismic loads  on a structure with meshed slabs

Automatically calculate static wind and seismic loads for floors in which floor diaphragm is not 

considered. In the old version, static wind and seismic loads were not able to be assigned if 

floor diaphragm was not considered. 
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Span-oriented input type for Beam Wizard has been newly implemented. In the new version, 

beam elements with different spans can be rapidly generated.

Type 1: Generate beam elements based on the beam length. Beam elements with different 

lengths can be generated simultaneously. (Ex. 5.0, 3.0, 4.5, 3@5.0) 

Type 2: Generate beam elements based on the distance between the nodes and the number 

of repetitions. 

Model > Structure Wizard > Beam

Old version Gen 2010

5. Enhanced Beam Wizard
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Thecompositesectiontab regardingthe sectionvariationbefore and after compositeactions

hasbeennewlyadded. Compositesectionprovidesthe followingthree sectiontypes:

Steel-Box:Structural steel Box Girder

Steel -I: Structural Steel I Shape Girder

User:Section properties defined as άDŜƴŜǊŀƭ {ŜŎǘƛƻƴέ in the Value tab

Model > Properties > Section

Tables >Structure Tables > Properties > Section

6. Addition of composite sections

Steel-Box type

Steel-I type
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Generatethe strip foundationsusing the upside-down T-shapebeam. Both the inverted T-

shapeand L-shapesectionscan be generated. Thesesection are useful in generatingstrip

foundations of a building. The design feature for the upside down T-shapebeam will be

implementedin the upcomingversion.

Model > Properties > Section

Tables >Structure Tables > Properties > Section

Upside-down T-shape section L-shape section

7. Addition of the inverted T-shape beam
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In IS808 section DB, H-Section and Channel

now reflectάǊέvalue.

Also,T-Sectionhasbeennewlyaddedin IS808.

8. Improvements in IS808 section DB

ChinesesectionDB(GB-YB05) hasbeennewly

added. The following section shapes are

availablebasedon GB-YB05:

Angle, Channel, I-section, T-section, Box,

Pipe, Double angle, Double channel,Cold

formed channel

9. Addition of Chinese section DB
(GB-YB05)

Model  >  Properties  > Section

Tables >Structure Tables > Properties > Section
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Inertial forcesresultingfrom responsespectrumanalysiscan be convertedto nodal loadsin

the specifiedloadcase. Theprocedureisasfollows:

¡ In theάbƻŘŀƭResultsof w{έtable,right-clickandselectά/ƻƴǾŜǊǘto NodalLoad.έ

¢ In theά/ƻƴǾŜǊǘto Nodal[ƻŀŘέdialogbox,selectthe desiredRSloadcaseandMode.

The ά/ƻƳōƛƴŜŘέcomponentof Moderepresentsmodalcombinationresults.

£Selector createloadcaseto generatethe nodalloads.

Results  >  Result Tables  > Nodal Results of RS

10. Converting Inertial Forces from RS analysis to Nodal Loads

3
2

1
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Cuttingdiagramcannow be displayed

for plane strain elements. In the old

version, this feature was availablefor

plateelementsonly.

Display cutting diagram for 2-D

structureswhichconsistof planestrain

elementssuch as dams,breakwaters,

tunnels, andretainingwalls.

Results  >  Stresses > Plane Strain Stresses

11. Addition of Cutting Diagram Display for Plane Strain elements

Model > Boundaries > Elastic Link

Analysis > Perform Analysis

Stiffnessof rigid typeelasticlink isnow producedin the analysisoutput file (*.out).

12. Display Stiffness of Rigid Type Elastic Link in the Analysis Output File
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Shading

View > Display Option

Shadingoption for solid and planer elementshasbeen newly implemented. With this option,

the usercanadjustthe transparencylevelof the shadingdisplay.

13. Shading for Solid and Planar Elements in Wireframe View

Randomelement color can be automaticallyassignedcorrespondingto the type of element,

material,or section.

For pre-generated 
elements, assign a 
random element 
color for a  
particular property 
by clicking the 
[Random Color] 
button.

For newly created 
elements, assign a 
random element 
color to each of the 
properties  by 
clicking on the 
ά!ǎǎƛƎƴ Random 
/ƻƭƻǊέ option.

View > Display Option

14. Display element color by element type, material type, or section type 

Draw tab Color tab
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A new feature that displaysthe Supportsand Point SpringSupports, offering an intuitive way

of identifyingboundaryconditions.

Model > Boundaries > Define Constraint Label Direction

View > Display > Boundary

Old version

Gen 2010
Support Point spring support

15. Enhanced Display of Supports and Point Spring Supports
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A new feature that canexport result tablesto an ExcelSpreadsheet. All valuesaswell astable

titles are exported to the spreadsheet. This feature is available for all the pre and post-

processingtables.

Results > Result Tables 

16. Addition of an export to Excel option in result tables

File > Graphic files > JPG files

Graphicalimageof the Model Window can

be savedin jpg format aswell asAutoCAD

DXF,BMP,or EMFformats.

17. Save an image in jpg format 
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File  >  Export  > Frame Section for Solid, Frame Section for Plate

[midasGen: line beam model]

[midas FEA: Imported tendons]

[midas FEA: Solid model]

TendonProfilesaswell asconcretegirdercanbeexportedto midasFEAfor detailedanalysis.

Theoption to export framemodelto platemodelin midasFEAhasbeennewlyimplemented.

The user can easilygeneratethe solid/plate model with tendons,which will be analyzedin

midasFEA.

18. Export frame model to solid/plate model 
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In the old version, if  a 
structure group ά{ŜƎр-мέ 
is newly created, it 
would be placed at the 
bottom of the group list. 

In Gen 2010, the user

can change the group

order relevant to the

constructionsequence.

Model  >  Group  > Define Structure (Boundary / load / Tendon) Group

Automaticallyarrangethe list of groupsin alphabeticalorder, or manuallychangethe order of

the groupsasdesired.

Thisfeaturehelpsthe userto quicklyorganizeandbetter understandthe groupdataespecially

for the constructionstageanalysis.

Old version

Gen 2010

19. Addition of Sort Groups by Name feature
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In Gen 2010, (-)X, (-)Y, and (-)Z 

directions are newly added.

102

103

201

202

203

204

301

302

303

304

305

401

402

403

101 reversed 
order

1

2

3

4

5 6 7 8

9

10

11

12

reversed 
order

Model  >  Nodes  > Renumbering

Renumberthe existingelement(node)numbersin reverseorderof the GCSdirection.

Forpile or frameelements,renumberthe element(node)numbersin the directionof gravity.

Model >  Elements  > Renumbering

Pile elements

Frame

20. Renumbering the existing element (node) numbers in reverse order
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Theusercanselecta LocalHelpor Web-basedHelpusingthe newpreferencefeature.

Whenά¦ǎŜLocalIŜƭǇέoption is checked,a Localhelp file (midasGen.chm) which hasbeen

installedonto the localcomputeris invokedby pressingtheάC1έkey.

The default is set to web-based Help, since it can be frequently updated with enhanced

contents.

[Web-based Help]

21. Addition of the Preference for online help

Tools > Preferences > Notice & Help
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Rigid Structure

Auto-generationof wind loadsaccordingto KBC2009hasbeennewlyimplemented.

In KBC2005, GustEffectFactorwasdeterminedbasedon the Roughnessin the corresponding

tablefor the rigid frame. In KBC2009, it iscalculatedfrom the equation.

Load > Lateral Loads > Wind Loads

22. Addition of auto-generation of wind loads 
according to the latest Korean Building Code (KBC2009)

Flexible Structure



Gen 2010Pre/Post Processing Enhancements Gen 2010 (v1.1) Release Note

25/ 68

Static seismicload and designresponsespectrumaccordingto KBC2009 have been newly

added.

Load > Response Spectrum Analysis Data 
> Response Spectrum Functions

Load > Lateral Loads 
> Static Seismic Loads

23. Addition of static and dynamic seismic loads 
according to the latest Korean Building Code (KBC2009)
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(1) Applying Plate and Solid Elements to Structural Masonry Material 

(2) Addition of Time Dependent Material as per Eurocode2:04

(3) Addition of Time Dependent Material as per IRC:18-2000

(4) Addition of the Time Dependent Material (Compressive Strength) 
as per CEB-FIP(1978) 

(5) Addition of distributed springs

(6) Addition of Pile Spring Supports 

(7) Addition of Multi-Linear Type Elastic Link

(8) Nonlinear Point Spring Supports for Construction Stage Analysis

(9) Accidental Eccentricity consideration for Response Spectrum 
Analysis in Basement Floors

(10) Considering Mass Participation Factor for Rotational direction

(11) Transfer reactions of slave nodes to the master node

(12) Improvements in Buckling Analysis Control dialog box 

(13) Improvements on the Eigenvalue analysis considering the 
maximum number of frequencies

(14) Enhanced pushover hinge properties of FEMA type 

(15) Buckling load consideration in the Pushover Yield Surface 

(16) Improvements in Inelastic Hinge Properties of SRC Beam member

ÇList of Detailed Enhancements in Analysis
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1. Applying Plate and Solid Elements to Structural Masonry Material

Plateelements,4-nodestetra solid,and 6-nodeswedgesolid elementscanbe appliedto the

StructuralMasonrymaterialfor plasticanalysis.

Model > Properties > Plastic Material
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2. Addition of Time Dependent Material as per Eurocode2:04

Time DependentMaterial (Creep/Shrinkage,CompressiveStrength, and TendonLoss)as per

Eurocode2:04hasbeennewlyimplemented.

Model > Properties > Time Dependent Material (Creep/Shrinkage)

Model > Properties > Time Dependent Material (Comp. Strength)

Load > Prestressloads > Tendon Property

Creep/Shrinkage

Compressive Strength Tendon Loss
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3. Update on Time Dependent Material as per IRC:18-2000

Time Dependent Material (Creep/Shrinkage, Compressive Strength, and Tendon Loss) as per 

IRC18:2000 has been newly implemented.

/ǊŜŜǇ ŦǳƴŎǘƛƻƴ Ŏŀƴ ōŜ ǎƘƻǿƴ ŀǎ άŎǊŜŜǇ ǎǘǊŀƛƴ ǇŜǊ млatŀέ ŀǎ ǿŜƭƭ ŀǎ ά/ǊŜŜǇ /ƻŜŦŦƛŎƛŜƴǘΦέ 

¬Creep/Shrinkage

Compressive Strength Tendon Loss

Model > Properties > Time Dependent Material (Creep/Shrinkage)

Model > Properties > Time Dependent Material (Comp. Strength)

Load > Prestressloads > Tendon Property
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4. Addition of the Time Dependent Material (Comp. Strength) 
as per CEB-FIP(1978) 

Time Dependent Material (Compressive Strength) as per CEB-FIP(1978) has been newly 

implemented. In the old version, only creep and shrinkage as per CEB-FIP(1978) were 

implemented. For the construction stage analysis, time dependent material as per CEB-

FIP(1989) can now be fully considered. 

Model > Properties > Time Dependent Material (Comp. Strength)

Ç Implemented time dependent material codes:

CEB-FIP(1990)

CEB-FIP(1978)

ACI209(1982)

PCA(1986)

Combined ACI & PCA

IRC:18-2000

Eurocode2-1-1:2004
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5. Addition of distributed springs

Distributed springs on the beam, plate, and solid elements.

Generate surface springs to represent the stiffness of the soil.

Consider accurate boundary conditions when modeling members on elastic subgrade. 

Compression-only spring can be considered.

Model > Boundaries > Surface Spring Supports

ÇDifference between Convert to Nodal Spring and Distributed Spring

When Convert to Nodal Spring is selected, springs are entered at the nodes of the 
elements. When Distributed Spring is selected, springs are uniformly distributed on 
a face or edge of the elements.

Convert to Nodal 
Spring

Distributed Spring 
(Winkler Spring)

Spring 
location

Nodes of elements Distributed on the elements 

Unit of 
reaction

kN
Beam: kN(kN/M)

Planar or Solid: kN(kN/M2)

Deformation
Concentrated
at the nodes 

As element stiffness increases, beam 
deformations are distributed throughout 

the elements.

[Surface Spring Supports Display]

[Reaction (Local-Surface Spring )tab]
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6. Addition of Pile Spring Supports

Pile spring support can consider the soil adjacent to piles as nonlinear springs. Nonlinear

characteristicsof springsoverthe pile heightareautomaticallyvaried.

Linear, compression-only, and Multi-Linear springs are automatically assigned to nodes

dependingon the springdirection.

Byselectingthe pile elementsandenteringthe geometrydata(groundlevel,pile diameter,etc.)

andsoilproperties,the springstiffnessat eachnodeisautomaticallycalculated.

Linear type

Point Spring Support

Model > Boundaries > Point Spring Support Table

Multi-Linear type

Point Spring Support

Model > Boundaries > Pile Spring Supports
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: Angleof internal friction of sand

:

:

: Unit weightof soil

: Activeearthpressurecoefficient

The relationship between the lateral soil resistance and the lateral displac

ement Y at a specific depth X is represented as shown in the figure on th

e left.

The values of Pk, Pm, Pu, Yk, Ym, and Yu are defined at a specific depth

(ex. where pile springs are located).

The method of calculating Pu varies with Soil Types. The values of Pk, P

m, Yk, Ym, and Yu are calculated using Pu as explained below.

The calculation method is divided into two major cases - Sand and Clay.

Different J values are used for Soft Clay and Stiff Clay.

ÇThe Stiffness of Nonlinear Elastic (Lateral) Springs for the Soils adjacent to Piles 

a. Calculation of Pu in the case of Sand Soil

The value of Xt denotes the depth when the following two Pu values are equal. Make the right terms of two equati

ons identically, rearrange the equation in terms of X, and solve the quadratic equation.

) ti X X ) tii X X

1 2 3 4[ ]u rP A X c c c c 5 6[ ]uP AD c c

0

1

tan sin

tan( )cos

K X
c

2

tan
( tan tan )

tan( )
c D X

3 0 tan (tan sin tan )c K X

4 ac K D

8

5 (tan 1)ac K rX

4

6 0 tan tanc K rX

: Ultimatesoil resistanceper unit length

: Empiricaladjustmentfactor

: Depthbelowsoilsurface

: Pilediameter

: Coefficientof earthpressureat rest

uP

A

X

D

0K aK
2[tan (45 / 2)]

/ 2

45 / 2

Where, Where,
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: Empiricaladjustmentfactor

: Constantvaryingwith relativedensity

: Pilediameter

: Empiricalconstant(0.5 for SoftClay,0.25for Stiff Clay)

: Depthbelowsoilsurface

:

b. Calculation of Pu in the case of Clay Soil 

Where,

[3 / ]u u uP D s rX Jc X D

9u uP s D

RX X

RX X

uP

us

uc

D

J

X

RX 6 /[ / ]uD s J

: Ultimate resistanceper unit length

: Undrainedshearstrength

: Undrainedcohesion

: Unit weightof soil

for

for

c. Computation of Points k and m

3

80
u

D
Y

60
m

D
Y

m u

B
P P

A

/(1 )

1/1

n n

n

m

DPm
Yk

k XY
1( / )k kP X D k Y

,A B

[ ( )] /[ ( )]m u m m u mn P Y Y Y P P

1k

2

1( / / )k MN m m

d. Spring Stiffness

The final spring stiffness is determined by multiplying the stiffness per unit area calculated above by the area.

u uP P A m mP P A k kP P A

Where,
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Where, : Pilediameter : Coefficientof earthpressureat rest

: Unit weightof soil : Depthbelowsoilsurface

: Internal friction angle

ÇThe Stiffness of Linear Elastic (Vertical) Springs for the Soils adjacent to Piles 

Thedirectionof the linearelasticverticalspringsfor the soilsadjacentto pilesshouldbe perpendicular

to the ground(GCS'-'Z direction). Eventhough the piles are not perpendicularto the ground,the Z-

direction(NodeLocalAxis)of the nodesfor Pilesshouldcoincidewith the GCSZ-direction.

tan 0 tanK D K

tan (1 sin ) tanK D X

D 0K

X

ForSand

ForClay
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P

̟

7. Addition of Multi-Linear type Elastic Link

Multi-linear type elasticlink hasbeennewlyadded. Thisfeature is extremelyusefulwhen we

model bilinear springsbetween bridge decksand rails to evaluate axial forces in the rails

considering nonlinear behavior of ballast due to a temperature and braking load.

Model > Boundaries > Elastic Link
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8. Nonlinear Point Spring Supports for Construction Stage Analysis

NonlinearPoint SpringSupportscan now be considered

in the ConstructionStageAnalysis.

Point springsupportscan be applied to simulateelastic

bearingpadswhenanalyzingbridgestructures.

The following types of Nonlinear springs can be

consideredin the constructionstageanalysis.

- Compressiononly spring

- Tensiononly spring

- Multi -Linearspring

Model > Boundaries
> Point Spring Supports

9. Accidental Eccentricity consideration for Response Spectrum Analysis

in Basement Floors

AccidentalEccentricityfor ResponseSpectrum

Analysisin basementfloors can be considered

by checkingon theά/ƻƴǎƛŘŜǊEccentricitybelow

G.[έoption. This option is checked on as

default.

Load> Response Spectrum Analysis Data
> Response Spectrum Load Cases
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10. Considering Mass Participation Factors for Rotational Directions

Massparticipation factors for all the rotational directionscanbe calculatedregardlessof the

άCƭƻƻǊDiaphragm.έIn the old version,massparticipationfactorsfor transferdirectionswere

onlyconsideredwhentheάCƭƻƻǊ5ƛŀǇƘǊŀƎƳέwasnot assigned.

Results > Vibration Mode Shape

Results > Result Tables > Vibration Mode Shape

Old version Gen 2010

Vibration Mode Shape

Vibration Mode Shape Table
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11. Transfer reactions of slave nodes to the master node

Analysis > Main Control Data

[Checked off - When reactions of slave nodes are 
not transferred to the master node]

[Checked on - When reactions of slave nodes are
transferred to the master node]

In the old version,reactionswere producedat the master node only when rigid links were

assigned. In Gen2010, the usercanselectif reactionsof slavenodeswill be transferredto the

masternodeor not.

When this option is checkedon, reactionsof slavenodesare plotted as zero and the total

reactions including reactions of slave nodes are plotted in the Summation field of the

ReactionsTable. When this option is checkedoff, reactionsof slavenodesare plotted in the

reactionfield of the correspondingslavenode.
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12. Improvements in Buckling Analysis Control dialog box

SturmSequenceCheckoption for detectingany missedbucklingload factor and LoadFactor

Rangeoption for settingthe rangeof the bucklingloadfactor havebeennewlyadded.

midas Gen consideredLateral-TorsionalBucklingmode in any case. The FrameGeometric

StiffnessOptionhasbeennewly implementedto ignorethe Lateral-TorsionalBucklingeffect in

BucklingAnalysis.

Analysis > Buckling Analysis Control

[Message window]

[Buckling mode shape]

[Buckling mode shape table]

1st 2nd 3rd
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13. Improvements on the Eigenvalue analysis 

considering the maximum number of frequencies

When the Number of Frequenciesexceedsthe maximum number of eigenvaluesfor a

correspondingstructure,the programautomaticallyupdatesthe numberof frequencies. In the

old version,anerror messagewasdisplayedandthe analysiswasterminated.

Old version Gen 2010

Analysis > Eigenvalue Analysis Control
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14. Enhanced pushover hinge properties of FEMA type  

In the old version, M/MY at the point D and E must have the same value. In Gen 2010, 

different values can be defined. This is applicable when the Interaction Type is άbƻƴŜέ and the 

Input Method is ά¦ǎŜǊ LƴǇǳǘΦέ 

This function is implemented to support the integration between SERCB win and midas Gen.

Design > Pushover analysis > Define Pushover Hinge Properties

[Pushover analysis result in Gen]

[SERCB win]
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15. Buckling load consideration in the Pushover Yield Surface 

In the pushover PMM hinge

properties, buckling load can be

considered in calculating yield

strengthby checkingon the άCalc.

YieldSurfaceof Beamconsidering

Bucklingέoption.

Design > Pushover > Pushover Global Control

16. Improvements in Inelastic Hinge Properties of SRC Beam member

Inelastic hinge can be now defined for SRC(encased) beam members. In the old version, 

inelastic hinge cannot be assigned to SRC(encased) beam elements. 

Model > Properties > Inelastic Hinge Properties
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ÇList of Detailed Enhancements in Design part

(1) Addition of Capacity Design as per NTC2008 and Eurocode8-1:2004

(2) Addition of Slab/Wall Design as per Eurocode2-1-1:2004

(3) Improvements in Rebar Input Dialog box

(4) Update rebar by members

(5) Addition of new rebar DB UNI standard 

(6) Improvements in calculating effective length in the steel structure 
according to the Chinese specification

(7) Addition of torsional design of RC beam as per TWN-USD92

(8) Addition of steel code checking as per IS:800-2007

(9) Auto-generation of load combination as per KBC 2009

(10) Addition of SRC Code Checking as per JGJ318-01
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1. Addition of Capacity Design as per NTC2008 and Eurocode8-1:2004

Capacity design provisions are required to

obtain the hierarchy of resistance of the

various structural componentsnecessaryfor

ensuringthe intended configurationof plastic

hingesandfor avoidingbrittle failuremodes.

In frame buildings, when including frame-

equivalentsystems,with two or more stories,

the following condition should be satisfiedat

all joints of primary or secondary seismic

beamswith primaryseismiccolumns:

Gen2010providesautomaticcapacitydesign

to satisfy the specifiedductility classes(DCM

andDCHfor Eurocode8, CDά.έandCDά!έfor

NTC2008).

Design > Concrete Design Parameter 
> Design Code

Design > RC Strong-Column Weak-Beam Design 
> Ductile Design/Ductile Checking

Design > Concrete Code Design 
> Beam Design / Column Design / Wall Design

(1) Define design code: 

(2-1)Perform Design : 

Rc RbM 1.3 M
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Where, MRb: Beam moment resistance

MRc: Column moment resistance (calculated using same axial force 
ratio in PM interaction curve)

Mce: Bending moment of column due to seismic load case

ÇBeam and Column Design forces for DCM & DCH as per Eurocode8-1:2004

Rɹd: Factoraccounting for overstrength 

Capacity design values of shear forces on beams

Capacity design shear force in columns
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ÇWall Design forces for DCM & DCH as per Eurocode8-1:2004
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ÇBeam and Column Design forces for DCM & DCH as per NTC2008

Capacity design values of shear forces on beams

Capacity design shear force in columns
Where, MRb: Beam moment resistance

MRc: Column moment resistance
(calculated using same axial force ratio in PM interaction curve)

Mce: Bending moment of column due to seismic load case

Rɹd: Factoraccounting for overstrength 
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ÇWall Design forces for DCM & DCH as per NTC2008

l cr w w
a h max l ,h / 6

Fig. 5.3: Design envelope for bending moments in slender walls Fig. 5.4: Design envelope of the shear forces in the walls of a dual system

Wall systems Dual systems

Ò For all types of walls, dynamic 

component of the wall axial force may be 

taken as being 50% of the axial force in 

the wall due to the gravity loads present 

in the seismic design situation. This 

force shall be taken to have a plus or 

a minus sign, whichever is most 

unfavorable. 
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DetailedReport

GraphicReport

Design Result Dialog box

Design Results

The automatic design results are based on the maximum negative/positivemoments and

shearforcescalculatedat the positions(I,1/4,1/2,3/4 & J)of eachmemberin accordancewith

the load combinationsfor concretedesign. Detailedcalculationcanbe verified in the graphic

report andthe detailedreport.
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2. Addition of Slab/Wall design as per Eurocode2-1-1:2004

Slab and wall design for meshed plate elements has been newly implemented as per

Eurocode2-1-1:2004. SlabFlexuraldesign& checking,Slabpunchingshearchecking, andWall

design& checkingfeaturesareavailable.

Text Output Two-way Shear Check (Punching Shear Check)

Design> Meshed Slab/Wall Design > Slab Flexural Design

Slab Shear Checking

Slab Flexural design : Required rebar area Rebar type and Spacing

Slab Serviceability Checking

Wall Design
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Design> Meshed Slab/Wall Design > 
Slab/Wall Load Combination

Design> Meshed Slab/Wall Design > 
Design Criteria for Rebar

Load combination for slab and wall design

Load combination for slab and wall design

can be chosenin the dialog box shown on

the right. All of the load combinations

generated in the Load Combinationdialog

box of the Slab Design tab (Results >

Combinations) are displayed here. This

function is useful when the engineerneeds

to apply some of the load combinations

suchasthe gravityloadfor slabdesign.

All of the load combinationsare checkedon

asdefault.

Specify reinforcement data for slab and wall design

Enterthe standardsizes

of rebars, spacing, and

concrete cover

dimensionin the design

of slab,mat foundation,

andwall members.

Cover dimension for

slab can be specified

differently for top and

bottom rebars.
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Design> Meshed Slab/Wall Design > 
Slab Flexural  Design

Flexural design

Flexuraldesignresultsfor slabelementsare

provided in contour, detailed report, and

designforcetable.

The following results are provided from

flexuraldesign:

Rebarspacinganddiameter

Requiredrebararea

Requiredrebar ratio

Resistanceratio

WoodArmerMoment

Wood-Armer moment: midas Gen provides design forces in the reinforcement directions for 

skew reinforcement based on the Wood-Armerformula.

From the analysis results,the following plate forces 
about the local axis are calculated:

Åmxx

Åmyy

Åmxy

In order to calculate the design forces in the
reinforcementdirection,angle ahnd˒will be taken
asshownin the figureon the right.

Where
x, y: local axis of plate element
1, 2: reinforcement direction

:h angle between local X-direction and reinforcement 
direction 1

:˒ angle between reinforcement direction 1 and 
reinforcement direction 2
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Firstly, internal forces (mxx, myy, and mxy) are transformed into the a-b coordinate system.

Then, Wood-Armermoments are calculated as follows:
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DesignResult

Detailedcalculationresultsare provided in the

detailedreport.

DesignForce

Wood Armer moments are provided for a

specified load case/combination in a spread

sheet format. When All Combination is

selected, the most unfavorable Wood-Armer

momentsare displayedwith the corresponding

loadcombinationfor eachplateelement.

UpdateRebar

Reinforcementresultingfrom flexuraldesignare

automaticallyupdated.

Design> Meshed Slab/Wall Design > 
Slab Flexural  Design

Flexural design report, table, and update rebar

Detailed report

Meshed Slab Design Force table Update Rebar
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Slab Rebarsfor Checking

Rebar for slab and wall checkingcan be assignedand replaced in this dialog box. Rebar

directionisspecifiedin the Sub-domaindialogbox.

Design> Meshed Slab/Wall Design > Slab/Wall Rebars for Checking
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For practicaldesign,smooth moment distributions

are preferred. By selectingthe smoothing option,

the program can considerthe smooth moment in

slabdesign.

Smoothing

Element: Designresults are displayedusing the internal

forcescalculatedat eachnodeof elements. (nosmoothing)

Avg. Nodal: Designresultsare displayedusingthe average

internal nodal forces of the contiguouselements sharing

the commonnodes.

(Example)Designforce for Node. EN21
In oneplate element,4 internal forcesexist. Forthe element
E2, memberforcesexistat the nodeEN21, EN22, EN23, and
EN24. The following equations show how the smoothing
option works for the node EN21. (Assume that rebar
direction is selected as Angle 2 for Width smoothing
direction.)
(1) Element+ Element: EN21
(2) Avg. Nodal+Element: (EN12+EN21+EN33+EN44)/4
(3) Element+ Width 2m: (EN11+EN12+EN21+EN22)/4

Element: Designresultsare producedfor momentsat each

nodeof slabelements. (nosmoothing)

Width: Designresults of slab elements at each node is

producedusingthe averageof the bendingmomentsof the

contiguousslabelementswith the specifiedwidth.

Avg. Nodal of EN33 =
(EN12+EN21+EN33+EN44)/4

Width 2m of EN33 =
(EN33+EN34+EN43+EN44)/4

2m

Average Nodal and Width smoothing

2m
1

2

EN73

EN72

EN83

EN82

(4) Avg. Nodal+ Width 2m: {(EN11+EN34+EN72+EN83)/4 + (EN12+EN21+EN33+EN44)/4
+ (EN22+ EN43+ EN51+EN64)/4 }/3

Design> Meshed Slab/Wall Design > 
Slab Flexural  Design
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One-Way Flexural Design

Producethe slab design results of the floor slab

elements along a cutting line. In one-way flexural

design,Wood-Armermomentsperpendicularto the

cuttingline areapplied.

Rebardimensionwith spacing,required rebar area,

required rebar ratio, and resistance ratio are

displayedin contours.



Gen 2010Design Enhancements Gen 2010 (v1.1) Release Note

59/68

Slab Shear Design

Producethe punching shear check results at the

critical perimeter of slab supports or the loaded

pointsof concentratedloadsandthe one-wayshear

check results along the user-defined ShearCheck

Lines.

ÇPunching shear calculation

ÁMaximum shear stress calculation

Case 1. vEd : platestressfrom analysis

Shear stress 
for each side

Design> Meshed Slab/Wall Design > 
Slab Shear Checking

Shearstressaverageby Element

averageby Side

Detailed report

Shear stress at the critical perimeter

V_Ed< V_Rd,c: section is safe in punching shear

V_Ed> V_Rd,c: provide shear reinforcement.

Asw/sr = (v_Ed-0.75*v_Rd_c)*(u1*d) / (1.5*d*fywd_ef)


